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1 Introduction

This manual describes the operation of the software application pco.vision developed by Excelitas

PCO. With this software, all current and most older PCO cameras can be operated.

This manual covers the software functions, while specific camera data and values can be found in

the corresponding camera manual.

Not all software functions are supported on all camera models.

1.1 Supported operating systems

This software applications is available for the following operating systems1:

• Windows 10 and later (64-bit)

• Ubuntu 20.04 and 22.04 (64-bit)

• Debian 11 and 12 (64-bit)

• Rocky/Red Hat 8 and 9 (64-bit)

1.2 Installation

This software application enables you to control camera parameters and settings from Microsoft

Windows or Linux operating systems. Images can be displayed on a monitor and may be down-

loaded and stored.

1.3 Windows

Download the pco.vision Windows package, unzip it, and execute it. Follow the installation wiz-

ard:

1 Select ”Install for anyone using this computer” to install to the Program Files folder, otherwise

it will be installed only to your user folder.

2 In the Choose components window, select additional drivers if needed: Silicon Software

DLL MeIV for Camera Link interface or Camera Link HS DLL CLHS for Camera Link HS

interface (for USB and USB3 the driver must be installed separately).

3 Choose install directory.

4 Click ”Install” and after the next two screens installation is complete.

1It is recommended to only use currently supported operating systems.
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After a successful installation, you will find the program folder PCO Digital Camera Toolbox in the

selected install directory (by default, Program Files) and a PCO software icon on your desktop.

To uninstall the pco.vision application, open ’Installed Apps’ in Windows Settings (formerly ’Apps

& features’).

1.4 Linux

This software application supports multiple Linux distributions. Download the pco.vision Linux

package that is compatible with your system from our website.

Ubuntu/Debian Download the *.deb package for pco.vision.

1 Install the dependencies:

sudo apt-get update && apt-get install libusb-1.0-0-dev, libxcb-←↩
cursor0

2 Install the *.deb file using:

sudo apt-get install ./pco.vision_*.*.*_*.deb

Rocky/Red Hat Download the *.rpm package for pco.vision. Install the file using:

sudo dnf install ./pco-vision-*.*.*-*.rpm

pco.vision Chapter 1
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2 Quick start

To get familiar with your new camera and software, it is recommended to first aim the camera at

an object that is visible under normal light conditions as well as easy to focus on.

2.1 Preparation

1 Computer is turned on.

2 Installation of pco.vision and camera specific driver is finished.

3 An appropriate lens is attached (remove cap) or the camera is attached properly to the mi-

croscope, spectrograph or other scientific device.

4 Camera is connected to the computer.

5 Camera is connected to the power supply and powered up.

2.2 First image

1 Start pco.vision.

2 A View Window is displayed (if not, go to the main toolbar and click View, View Windows,

then select the camera in the list).

4 Start Preview by clicking .

5 If the image is still too dark or too bright, adjust the Exposure time (chapter 3.3.2) and the

aperture and focus of the mounted lens.

6 Keep on adjusting until the object is in focus and can be seen clearly.

To learn how to record and save images, go to chapter 3.3.4 and chapter 3.6.

pco.vision Chapter 2
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3 pco.vision software

3.1 Camera Overview

The Camera Overview window controls how the camera properties are display. The color of the

text for the properties associated with the selected camera can be specified. This is helpful when

multiple cameras are connected, as each camera can be assigned a different color. There is also

a box to select whether a histogram will be displayed for the selected camera.

3.2 View Window

Images from the selected camera are shown in the View Window.

To open a ViewWindow for a selected camera, go to the Viewmenu, ViewWindows, and select the

desired camera from the dropdown list. Read-only information on ”Pixel Values”, ”Image stats”,

and ”Performance stats” may be displayed in the lower left corner of the window. This information

can be enabled or disabled in the right-click menu of the window.

Display Range The settings to change the Display Range are also located in the right-click menu. Use these to

adjust the display contrast.

• Auto Range: The display settings are adjusted based on the minimum and maximum pixel

values detected.

• 3Sigma: Display settings are based on the average pixel value +/- 3 sigma.

• 5Sigma: Display settings are based on the average pixel value +/- 5 sigma.

• Manual: Enter the maximum and minimum values to display.

Zoom Use the Zoom options in the right-click menu to zoom in or out of the image. Alternatively, you

can also use the scroll wheel.

3.3 Camera Settings

The Camera Settings window is the main interface for all camera settings. These settings are

applied to the active camera, selected from the camera list in the main toolbar.

A brief explanation of each setting is displayed as a tooltip when the cursor hovers over it.

The settings are divided into four categories: Camera Info, Timing, Image, and Recording.

To return all settings to default, click on Reset to Default at the bottom of the listed settings.

3.3.1 Camera Info

This section lists the name, serial number and type for the selected camera, along with the max-

imum frame rate possible when the current settings are applied. These parameters are read-

only.

pco.vision Chapter 3
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3.3.2 Timing

This is the section for setting both the Exposure Time and Delay Time and for selecting the Pixel

Rate and the Autoexposure settings.

Exposure Time The possible values for these parameters depend on the camera model.

Delay Time The possible values for these parameters depend on the camera model.

Pixel Rate The pixel rate (or scan rate) is fixed for certain camera models.

Autoexposure If Autoexposure is enabled, this setting will find the optimal exposure time between the maximum

and minimum time values specified. The pixel values are optimized for the specified region.

There are 4 different types of regions available:

• ’balanced’ (default)

• ’center_based’

• ’corner_based’

• ’full’.

The size of the pixel clusters is fixed, but depends on the overall image size and is treated sepa-

rately for width and height:

• For width/height ≥ 1300 the cluster size is 100.

• For 1300 > width/height ≥ 650 the cluster size is 50.

• For 650 > width/height ≥ 325 the cluster size is 25.

• For width/height < 325 the cluster size is width/height.

Balanced:

The measurement fields are positioned centrally and in all four corners.

Center-based:

All measurement fields are positioned in the center.

pco.vision Chapter 3
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Corner-based:

There are measurement fields positioned in all four corners.

Full:

The measurement fields are placed across the entire image.

Autoexposure may be switched on or off during recording, however its parameters can only be

changed when recording is off.

3.3.3 Image

The Image section includes settings for the Region of Interest (ROI), the Timestamp and the

Noise Filter.

pco.vision Chapter 3
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ROI The ROI can be specified by entering the top, bottom, left and right coordinates of the ROI bound-

ary.

Timestamp This is used to add a Timestamp to the image. The timestamp is calculated by the camera

firmware and added to the top, left section of the image. It can have various formats, though

not all are supported in every camera model:

• Off: no stamp

• Binary: stamp is encoded as BCD, replacing the first 14 pixels of the image

• Binary & ASCII: ASCII characters are placed in the image to the right of the binary time

stamp. These characters are human-readable and replace the image data.

• ASCII: ASCII characters are placed in the top, left corner of the image. These characters are

human-readable and replace the image data.

Noise filter The Noise filter can be turned on or off. This is a dynamic filter that can be activated to remove

so-called blinkers and high-noise pixels. If you encounter unexpected aliasing effects, turn this

filter off.

3.3.4 Recording

In this section, you can select the Trigger Mode, the Record Mode, how images will be stored

by choosing the File Format and Data Format, as well as the Image Count.

Trigger Mode A number of trigger modes are supported by this application:

• Auto Sequence: The camera determines the highest possible frame rate based on the set

exposure time and the time required for a frame readout. When recording starts, continuous

image acquisition begins and continues until recording stops.

• Soft Trigger: Only single images are captured in this mode. One image is acquired each

time the Trigger button in the main toolbar is clicked.

• Ext. Exp. Start: In the External Exposure Start mode, single image recording is triggered by

the rising edge of the signal at the input connector. The frame rate is defined by the frequency

of the external signal. Exposure time and ROI settings affect the maximum possible frame

rate.

• Ext. Exp. Ctrl.: In the External Exposure Control mode, single image recording is triggered

by the rising edge of the signal at the input connector. The duration of exposure is also de-

termined by the received signal, as it is ended when the falling edge of the signal is detected.

Record Mode There are three record modes to choose from. Recording can be performed as a single Sequence

or by a rotating Ring Buffer. Images can also be directly saved to disk when the File mode is

selected.

• Sequence: The number of images specified in ”Image Count” are acquired to memory, then

the recording stops.

• Ring Buffer: The number of images specified in ”Image count” are acquired to memory,

then the images are overwritten from oldest to newest.

• File: The number of images specified in ”Image Count” are directly saved on disk in the

format selected in ”File Format”.

pco.vision Chapter 3
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File Format This is only available in Record Mode ”File”. Select the desired file format from the dropdown list.

Data Format Depending on the camera model, the image data can be stored in different formats. Select the

desired data format from the dropdown list.

3.4 Video Control

The Video Control window controls the playback of recorded images. The slider can be used to

scroll through the images. Controls are provided to playback the images in sequence and to step

through the images.

3.5 Main toolbar

The main toolbar contains the Histogram, Save latest Image, Preview, Record, Trigger, Scan for

Camera, and Perspective button and a dropdown menu with a list of all cameras.

3.5.1 Histogram button

Pressing this button opens a new window displaying histograms for all listed cameras with the

histogram enabled. Vertical cursors are placed at the max and min points of the selected display

range. Moving the cursors will adjust the display range.

The histogram can be rescaled using the scroll wheel of the mouse. The scroll wheel adjusts the

vertical scale, and Shift+scroll adjusts the horizontal scale. Alternatively, the horizontal scale can

also be adjusted by right-clicking in the histogram window and entering the desired values.

pco.vision Chapter 3
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After rescaling, the plot can be repositioned by dragging it with the mouse.

3.5.2 Camera list

The camera list is a dropdown menu on the main toolbar that allows you to select a connected

camera. Selecting a camera updates the Camera Settings window to show that camera.

3.5.3 Preview button

Clicking the Preview button starts image acquisition for the selected camera. Preview images are

displayed in real time to assist with camera setup and are not saved to memory or disk.

3.5.4 Record button

Pressing the Record button starts the camera and captures images as specified in the Camera

Settings window.

3.5.5 Trigger button

Use the Trigger button to capture an image when the Soft Trigger mode is selected (see chapter

3.3.4 Trigger Modes).

3.5.6 Scan for Camera button

Pressing the Scan for Camera button prompts pco.vision to detect all cameras connected to

any interface. All found cameras are added to the camera list on the main toolbar and the View

Windows list in the View menu.

pco.vision Chapter 3
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3.5.7 Perspective button

The Perspective button allows saving or restoring the configuration of the windows. This way it

is possible to customize the look of the application for various use cases. If there are multiple

users, each can configure the layout and save it for future use. Saved perspectives appear in the

dropdown list at the bottom of the perspectives menu.

3.6 File menu

The File menu contains all options for saving images:

• Save latest image: Saves the currently displayed image directly to a preset folder in a preset

format. On first use, you will be prompted to select the folder and format. If ’Save current

image as’ was used previously, those settings will be applied automatically.

• Save current image as: Saves the currently displayed image. A dialog opens for each image

to select the folder and format.

• Save all images: Saves every image currently in the recorder memory. A dialog opens to

select the folder and format for all images.

3.7 View menu

In the View menu, you can select which windows are displayed. Choose from Camera Overview,

Camera Settings, Video Control, and the View Windows list. This list includes all detected

cameras, as it is based on the Camera List in the main toolbar.

You can display a single window, multiple windows, or all windows at once. The layout of these

windows can be customized by resizing, repositioning, or docking them to suit your workflow.

3.8 Color Theme menu

The look of the user interface can be changed by selecting one of the options in the Color Theme

menu. The available themes are PCO (blue), Green and Orange.

3.9 Log Level menu

The settings in the Log Levelmenu are used to collect information on the camera environment and

calls to the driver. This is useful in troubleshooting problems with the PCO cameras and software.

The log level settings control the amount of detail in the logs. Detailed logs can help diagnose

difficult problems, but a high level of detail can affect system performance, especially once the log

files become very large. The available settings are:

• Off: No logging

• Error: Logs error messages

• Warning: Logs warnings from the driver

• Info: Logs system information

• Debug: Logs all relevant information.
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The log files are located in the config/logging directory, i.e. C:\ProgramData\pco (Windows) or

\$HOME/.pco/pco_logging/ (Linux).

3.10 Help menu

The Help menu displays the version information for pco.vision and provides a link to our website.

There you can find driver and software updates.
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4 About Excelitas PCO

Pioneering in Cameras and Optoelectronics (PCO) has been our shared philosophy since our es-

tablishment in 1987. Starting with image-intensified cameras, followed by the co-invention of

the groundbreaking sCMOS sensor technology, PCO greatly surpassed the imaging performance

standards of the day. Acquired by Excelitas in 2021, our PCO camera portfolio continues to forge

ahead as a leader in digital imaging innovation across diverse applications such as scientific and

industrial research, automotive testing, quality control, and metrology.

With sophisticated mechanical design, extensive software support, and a broad range of acces-

sories, we deliver adaptable solutions for all demands. This adaptability extends to tailor-made

firmware and custom image sensors, which allow us to develop highly specialized solutions for all

our customers. PCO represents a world-renowned brand of high-performance camera systems

that complement Excelitas’ expansive range of illumination, optical, and sensor technologies and

extend the bounds of our end-to-end photonic solutions capabilities.

Our comprehensive camera portfolio covers the entire spectrum - from deep ultraviolet (DUV) to

shortwave infrared (SWIR), from long exposure to high-speed, from line scan to high-resolution

area scan. Our camera systems are controlled and processed through an intuitive and powerful

software suite addressing an extensive range of platforms and architectures.
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